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Starting a GOWIN FPGA Designer Project

1. Go to File > New.

ject Tools

Window  Help

e M
New.. CtrleN h
Open. Ctrle Q. Quick Start
Mew Project, Open Prject Open Bxample Project.
Close *Start Page )
Close All Tools.
: = : po
. = e i
o FlaorPlannes  Timing Constraints Editor  Pragrammer
Recent Files »
S : T
Exit
e et
Start Page o
Recent Projects:
Quick Start
expla_1
ram gt f :
D:\User Fites\D Mew Project, Open Project. Open Example Praject..
fpga_project
fpga_project Tools
fpga project = B 1PGA Design Proect
o E
FloorPlannes
& Verlog Fle
3 DL il
T

Creste a FPGA design project.
Manualfor Lief | %ou 4 or cre
route, and program your device.

& Physical Constraints File

4 Timing Canstraints File

will be able to. ad:

ste RTL sources, run synthesis, place &

Cancel

Start Page

1 | EEE 6744 Hands-On Hardware Security

University of Florida



()
2

=
O
<
O
a
L
=
=
o
O]

er - [Sar

3. Type the name of the project and its location. Click Next.

% Ji::

&=

Recent Projects:

Di\User_Files\Desktop\exptd_T\exptd
ram test
Di\User_Files\Documents\ram testir

B Project Name

Project Name

SelectDevice  Enter a name for your project, and specify a y be stored, oy will e created i it doesn't
foga_project R axist
D:\User_Files\University of Florida\Hi ummary
fpga project
DAUser_Files\Documents\fpga_proje
fpga project
DA\User_Files\Desktop\fpga. project

Nome  expta ]

Create in: D:\User Files\Desktop

() Use as defauit project location
Negs Cancel
e
Start Page [x]

C) according to the screenshot below. Click Next and then Finish.

4. Select the device (GW1N-UV9LQ144C6/I5 ver.

o

X

-8 x

Recent Projects:
expta 1

Di\User_Files\Desktophexptd_T\exptd
ram test
Di\User_Files\Documents\ram testid

fpga_project

Project Name
& Select Device

Select Device

Specify o target device for your project

. Filter
Di\User Files\University of Florida\Hs S,
foga_project Series: GWIN v Packege | LOFPIA -
fpga_project B =
Pert Nember Devce Deiceversion Package | Speed | Voltage
GWIN-LVILQ144C6/15 GWIN-9 C LOFP144 [<71) w
Start Page [x]
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5. If you would like to copy experiment codes to your project, move them to <project_name>/src/ folder.

8 Experiment_4_code_HaHav3

€ 5 v 4 B> Eperime . - C g A > epl > sic

A Home Name fie = Name

ap
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View
Sort by

Group by

Refresh
Customize this folder...

Paste
Pastihorteut

Undo Copy

B pin_assigments

@ New ~

4 | > pin_sssigments C c v s eprl

Name Type @ Home Name
$ gowin_pin_assignments Y CSTFile . imp!
[ B

eptd 1

View
Sortby

Group by

Refresh
Customize this folder...

Paste

Paste shortcut »

Undo Copy CtrisZ

Titem | 1item
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7. Inthe GOWIN FPGA Designer window, add existing files by right clicking on <project_name> on the left sidebar. Click Add Files... button.

Q
e Select all the files inside <project_name>/src/ folder. Click Open.
S -
GOWIN FPGA Designer - [Design Summary] <
O i ot prace T o el
<t Dk o BB e i EX G2
e T ottt Fe e,
[ NewFile. Project File: D:\User_Files\Desktop\expt4_1\exptd_1.gprj
GV
Z B |Gl Synthesis Tool: GowinSynthesis
=
O Part Number: GWIN-UVSLQ144CE/15
(U] Series: GWIN
Device: GWIN-9
Device Version: c
Package: LQFP144
Speed Grade: /s
Core Voltage: uw
Design  Process Hisrarchy 7 Start Page (] Design Summary []
Console & x
%
Console  Message

8. If you need to create a new file, right click on the left sidebar and clicking New File... button. You can select any of the listed file types. For
this example, Verilog File was selected. Then, click OK.

mmary] - o x
He 8 %
, o . TERIE| &y 0
] g B & WL §Ee e
Design 8 x
v 7 oxptd 1 - [DAUser_Files\Desktopl.
GWIN-UVSLQ144CH/15 Project File: D:\User_Files\Dasktop\exptd_1\exptd_1.gpri
5 Synthesis Tool: GowinSynthesis
~ [ Verilog Files
2 e _
stcvdesy part
sreldiviy Series: ~ Files
srckey_sel.v Device: B VerilogFile
= srdvamiy Device Vel [ vHDLFile
= scsboxly Pacagd [ Physical Constraints File
= srcsborzy Speed 6rd [ Timing Constraints File F
= srsbody Core Vol [ GowinSynthesis Constraints File P
R | [5} User Flash Initslization File P
= srcsbodsy Create a Verilog HOL file.
Design  Process Hierarchy 7 Start P a
Console | [ & x
Cancel
%
Co Messag:
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9. Name your file (no extensions). For this example, top is the name of the module. Click OK.

% {4 GOWIN FPGA Designer - [Design Summ _ o
‘5 .lEx
(U] B&MNEM e S
Design & x
5 ~ 7 expta 1 - [Da\User Files\Desktop..
o [ swin-waLqrascens Project File D:\User_Files\Desktop\expta_1\expt4_1.gpri
o « (B veiog e Synthesis Tool: GowinSynthesis
= sredesy Part Number: GWIN-UVSLQ144CE/15
= e =
(@) srckey_sely
5) srcramly
srcisborly s [ 5 -
srclsbordy
sreboci Createin: D:\User_Files\Desktop\exptd_T\src Browse,
src\sbordy 1 Add to current project
srclsborsy
Design  Process  Hierarchy,
Console 8 x
B
Console  Message

10. For this example, a top module was created as a blank text file. IT IS HIGHLY RECOMMENDED TO USE THE sample_top.v INSIDE THE
HaHav3_helpful_codes.zip FILE. This file ensures the pin assignments file map to the correct port names in this file. The module below is a
slightly modified version of the sample_top.v file. DO NOT USE THE BELOW VERILOG CODE.

Deign  Process | Hierarchy Start Page Design Summasy wp [~]

Iné Cok22
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Synthesizing a circuit and assigning pins

1. Run the synthesis tool by changing the left sidebar to Process. Right click on Synthesize and Click Run.

GOWIN FPGA Designer - [04

File Edt Project Tooks

Files\Deskiophexptd_T\src\iop]
Window  Help

Process

Design Sumemary

v R User Consines
FloorPlaries
Timing Condtrsints Edtor
v @ syrthesice
Synthesis Report
etist Fie
v BE Placedhoute
Place & Route Report
Taning Ay Regort

Ports # Pins Regort

& x

Bun

Rerun

Ferun All
ClesngRerun Al

Configurstion

Power Ansysis Report
B Program Device
Deign  Process  Hietarchy Stat Page Design Summary topa []
Cansole ax
\
Comsole Message
& Cob2z
PGA Desig e = o
) File Edt Projct Tools Window Help NEE
= | G e &
Hierarchy ex |1
2
= & Updste 5
Unit File :
Y ltee SIWOP!  Goto Module Instantiation
v deslded) sie\dest Gotg Module Instantiation With... >
diviC. sre\divi;
 des.. scdess G0t Module Defintion
Goto Module Defintion With. >
v . scaps
siclsbox  Pack User Design
O ) et s Top Modu
[ Set As Top Module
sre\sbox £ N
Clear Top Module
srcisbox
srcisbors.y
srclsborby
secisbory
srcisborty
Design  Process  Hierarchy ? Start Page Design Summary r topv a
Console & x
L0002) : The module
2) : The module
: The module
b The module
WARN ) : The module t
[95%] Generate netlist file "D:\User_Files\Desktop\expt4 1\impl\gusynthesis\exptd_1.vg" completed
[100%] Generate report file "D:\User_Files\Desktop\exptd 1\impl\gusynthesis\exptd_1_syn.rpt.html" completed
GowinSynthesis finish
Console  Message
6 Cot22
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3. Switch back to Process tab on the left sidebar. Right click on FloorPlanner and select Run. Click Yes when it prompts to create a CST file.

e} esig Desktop\exg =]
'5 ) File Edit Project Tools Window Help _|& x
O % B 58 <
< Process x| 1
2
) 1 | Design Summary 5
o ~ [ User Constraints :
[N |4k FloorPlanner 3
— N
= Timing Constraints E e |3 b
— ~ @ synthesize g
@ sy 0
; Synthesis Report 1
12
o Netlist File be
O ~ [ Place i Route 14
Place & Route Report
Timing Analysis Report
Ports & Pins Report
Power Analysis Repart
It Program Device
Design  Process  Hierarchy ? Start Page Design Summary 3 topr [x]
Console 8 x
) : The module "
: The module
The module
The module ™
( } : The module "divi antiated to "Uc pt in optimizing("D:\User_| s
[95%] Generate netlist file "D:\User_Files\Desktop\exptd 1\impl\gusynthesis\exptd 1.vg leted
[100%] Generate report file "D:\User_Files\Desktop\exptd_1\impl\gusynthesis\exptd_1_syn.rpt.html" completed
GowinSynthesis finish
Console  Message
Ini6 Col:22

4. In the FloorPlanner tool, go to File > Open.

FloorPlanner

File Constraints Tools View Help

0 New. Ctrl+N
Cpen
8 X chparay Package View
FH save Ctrlss & Ll e
B SaveAs Crl+ Shift+§
@ Reload

Exit

Summary  Nefist

Message & x

> Reading device GV IN-0C padkage LOFP 144 partnumber GW IN-UVSLQ144CH TS
> D s 3

> Parsing netist file D/ser_Fies/Desktop/expt_Limplfgwsynthesis/exptd_Lvg” completed
> Processing netist completed

> Reading constraint file: "D: User_Fies/Deskiop/expt4_1jsrc/exptd_Lest"

> Physical Constraint parsed compieted

Message  1/OConstraints  Primtve Constrants  GroupConstraints  ResourceReservaion  Clock Assignment  Quadrant Constrants  Hk Constraints _ Vref Constraints
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5. Inthe Open Physical Constraints wmdow click Browse next to Constraint File. Open the <project_name>\gowin_pin_assignments.cst file.

W < W
OERE@
Process Netist 8%  chparay[  Pacage View
1 | DesignSumn > & top
~ [ User Constra
[2 FloorPlar)
5 Timing € I
~ (@ synthesize
Synthesi
Netist Fil
v BE paced Rou Open Physical Constraints ? X
Place &
Netist Fie: w
Timing Al
ol Constraint File: D:/User ¥ 1jgowin_pin w
o Part Number:
# Program D

()
i

5
O
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Design  Process

Console

Summary  Netist

fessage.

WARN Reading device GWIN-SC pockoge LOFP144 parnumber GWIN-UVSLQ144CS13
[95%] Generate > hesdngnetiothe: s iefDesaon Expia. Limplovembess ot 1

[160%] Generat > Persng DifUser 3 +_Tvg" completed i

Processing netist completed

6owinSynthesis - Readng constraint fle: :/User_Fies/Desktop/exptd_1/srcjexpts_Lest”
Message  1/0 Constrants  Primtive Constrants  Group Constraints Tock t In: 11 Cok0

Physical Constraint parsed completed

Console  Messag

6. Click Browse next to Netlist File. Open the <project_name>/impl/gwsynthsis/<project_name>.vg file.

w W

Process Hesist

1] tesigr Sumn

v [ User Constrai
L bl
ing C
w (D synthesize
Synthesz
Helist il
~ B8 Plce ol
Place &R
Nt P T —
Timing &
Aol 0tjuser RENDESNEDAEE_ L0NN [, S
Pavser i Farthumber
i Program e
Design Pracess
Console ax
o
[55%] Generate
[186%] Generat: —— :
Gowinsynthasis
K - |
Corscle | Mesn] L
Musam 1O COTSUSNI PrIUs CoUANT | GOUPCONSTANES | RescuceRessrvaton | CodAssgment | QuadrantConsTan | MdcCorsTanm | wiefCorsTants =
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7. Click Browse next to Part Number. Configure the device as follows and click OK. Click OK again.

Process

Netist

chiparay £ Package View

1| Design Sum

~ [ User Constra

I8 Program D

[ Floorplar}
= Fiter
=
Timing €
~ 3 Series cwiN + | Padage: |LQFP144 -
O Synthesize Device: Gwins v Speed: Cons -
Synthesi Device Version: 5 .
o Ve b il verion
Netist i
~ 22 place & Rou Part Number Device Device Version Package  Speed Vu\(age 10
| GWIN-LVELQ144CH/15 GWINS LarPias o5 Ly )
ming
Ports &
Power A

> B top

Design  Process

Console

[95%] Genarate
[160%] Generat:
GowinSynthesis

Console  Messag

L

Rea
B Raadm netit Rl DLser ies/Deskiop ot Jimpligusmess/ets L

g
¥ vg" completed
 Povesing netistcarplicd
> Readng constran le: " Lser e Desktop/esotd._Lrc/etd_L st
> Physical Constraint parsed complete
Message  1/O Constraints  Primitive Constraints _ Group Constraints, Tock t In: 11 Cok0

8. On the FloorPlanner window, click File > Save As... button. Navigate to <project_name>\src\<project_name>.cst file. You can overwrite.

Process
1| Design sumn]
~ [ User Constra
[Z2 Floorplar
P Timing

v (@D synthesize
Synthes
Netist i
~ [ Place &tRout
Place &
Timing A

Ports &

Power A

J# program D

Design  Process

|
L6002)
(NL00O2)
002)

Console

Save As

& 3> v 1 B8 DAUser Files\Desktop\exptd_ T\sre

Organize ~
B xmega-intro # Name Type
» 5 el / PN CSTFile
@ Music »

B9 01 Research #

[95%] Generate
[160%] Generat
GowinSynthesis

Console  Messag

Message  1/OConstrainis  Primitve Constraints  Group Constraints  Resource Reservation  Clock t 11 Cok0
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9. Change the bottom tab to I/O constraints. Review the pin assignments below. The next section is optional. If you want to program the FPGA,
go to Appendix D.

W oorPla [m]
3 e Conaraintz Toois View  Help o
bl £ =
DEAE@
Process INetist 8 X| chpAray[[  Package View

1 | Designsumy > # top
~ [ User constral
[20 Floorplai
. Timing ¢

~ @ synthesize
Synthesi

()
i

5
O
<t
O
a
[T
=
=
o
O]

Netiist Fil Summary  etist

v [ Place & Roull/O Constrants 5 x
Place & Port Direction Diff Pair Location Bank Exclusive 10 Type Drive Pull Mode: P
Timingd] 1 CLK input Dee 1 False LveMoste up
Pots &R swlo] input P 2 False Lvemoste up
PowerAf ;  gupi] input 49 2 False LveMoste up
18 Program D
4 szl input s 2 False Lvemoste up
Design  Process | 5 gu[3] input 47 2 False LVCMOS18 up
Gz 6 swi4 input 46 2 False LVEMOS18 wp )2
WARN
7 swis) input el 2 False Lvcmoste up
& swiel input w“ 2 False Lvcmoste up
WARN e swin input s 2 False Lvcmost up
WARN
[95%] Generate| 10 WIS input 2 2 False Lvcmost up
[160%] Generalj 11 y1q) input a 2 False LveMosTs v
GowinSynthesis|
Console  Messa
Messoge | 1/0 Constrants  Prmitve Corstrants | Graup Constrants ock ¢ Vref Constrants In11_Cok:0
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Setup GOWIN Analyzer Oscilloscope file (Optional)

1. Create a new file with type GAO Config File. Click OK.

()
2

=
O
<
O
a
L
=
=
o
O]

D:\User_Files\Desktop\exptd_1\impl\gwsyn
ser_Files\Desktop\exptd_1\impl\gusyn

xptd_1.vg" completed
xptd_1_syn.rpt.html™ completed

Dasign ax

\ser_Files\Desitop) 3

1440615

GAO Setting

Type
O ForRTL Design

) For Post-Synthesis Netlist
Mode
Seandasd

O Lie

For RTL Design, analyse rt design.

For Post-Synthesis Netlist, anshye post-ynthesis netit.

Desigr [x]
Consale ax
tantiat o "Uclk™ 1s swept i il d
User_F1iles\Desktop\exptd_1\ingl\gwsyn xptd_1.vg" cospleted
:\User_Files\Desktop\expta_1\ingl\gusyn xptd_1_syn.rpt.html” completed
Console  Messagy
1 Cok0
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3. Enter a name or leave it as it is. Click Next and then Finish.

(]
o P = U
5 3 _lax
(U] = & W e «
Design g x| 2
< 2
(G) ~ 7 exptd 1 - [D\User_Files\Desktop\.. 3
Pt
o [&] swin-uvaLarscens sE
(N ~ Verilog Files : s
=z Py 2 GAO Configure File
= sre\desy B GAQ Setting
; i o B> GAO ConfigureFile  Enter a name for your GAQ configure file,
Summary
(@) src\key_selv
(U] sechaml.y
sectsboxly
stctsbox2y
stcshody
sectsboxdy
stctsboxSy
Design  Process  Hierarchy ? [x]
Console Name: o 8 x
The module in
: The module in
The module in
e module b < Back Next > Cancel
The module " instanTIaTEnTo TS SWepT TN OPTIMIZING( DT\USEr_FIIeS\DeSKTop\expTa_hysreaes=v 1 79)
RN (NLO@O2) : The module instantiated to "Uclk” is swept in optimizing("D:\User_Files\Desktop\exptd_l\src\des.v":
[95%] Generate netlist file "D:\User_Files\Desktop\exptd_1\impl\gusynthesis\exptd_1.vg" completed
[100%] Generate report file "D:\User_Files\Desktop\exptd_1\impl\gusynthesis\exptd_1_syn.rpt.html" completed
GowinSynthesis finish
=
Console  Message
In:11 Cok:0

4. Inthe Design tab, open the src\<project_name>.rao file. Click on ... button next to Clock.

File Edit Project Tools Window Help _ax
K 5 W e -
esign x
Deg & Capture Options
srclsborl.y
Capture Signals
src\sbox2.v Seklaes
@ Add Remove
sre\sboxdv ock: vise
src\shoxdy Sample O © Rising O Falling
siclsbors.y Capture
src\shoxby Capture Amount: 1024 -
src\sboxT.v GAQ Implementation;  ESRAM
sic\sboxd.y () Enable Capture Data Input Register
stcltop () Capture Initial Data
~ [ Physical Constraints Files
Capture Utilization
sre\exptd_l.cst BSRAM Usage: 0/26
~ | GAO Config Files =
 srleptd Lo
Design  Process  Hierarchy ? Start Page Design Summary /7 top exptd_lrao” ]
Console 8 x
: The medule “s i d to "us" izing("D »_Files\Desktop\
The module
The module
: The module
The module " P
W (NL@0O2) : The module "divi” instantiated to "Uclk” is swept in optimizing("D:\User_Files\Desktop\e:
[95%] Generate netlist file "D:\User_Files\Desktop\expt4_1\impl\gusynthesis\expt4 1.vg" completed
[160%] Generate report file "D:\User_Files\Desktop\exptd_1\impl\gusynthesis\exptd 1 syn.rpt.html" completed
GowinSynthesis finish
%
Console  Message

12 | EEE 6744 Hands-On Hardware Security University of Florida



()
2

=
O
<
O
a
L
=
=
o
O]

5. Search for CLK or whatever clock signal you used. Click OK.

X
H _lax
JH=) 1 K7
Down 8 X Copture Options
srctsboxdy Sampl= Clocl N o @ s
stcsboxdy Rl | = e
B wcshoudy Sample On: @| © Normal O Wildcard O Regulor Expression (0 Case Sensitive A5
— [ Advanced Filter
sresborSy Capture
> des/Uclk/ent[25:0]
stcsborbiy Capture Amou| |
secsborTy 6O Implemen | desclin
des/clk
stcisbordy () Enable Capt] | des/Ucliv/clkc
T Capturelni | des/Uelkiclkout
© e des/UT/clk
~ [ Physical Constraints Fil
slcal Constraints Hles Capture Utilizat | des/U2/clk
stc\exptd_Tcst v o
~ [ GAO Config Files =
stc\exptd_Trao
Design  Process  Hierarchy. ] Start Pai exptd_Trzo ™
Console | | 8 x
RN (NLO®O2) : The module "sbox6" instantiate
RNl (NLO@O2) : The module "sbox7" instantiate
RNl (NLO@O2) : The module "sbox" instantiate
WARN (NL@O@2) : The module "key_sel” instantig
WARN  (NL80G2) : The module "raml" instantiate
RN (NLO®O2) : The module "divi" instantiate ok ) Concel
[95%] Generate netlist file "D:\User_Files\Des
[100%] Generate report file "D:\User_Files\Desktop\exptd 1\impl\gusynthesis\exptd 1 syn.rpt.ntml" completed
GowinSynthesis finish
=
Console  Message
OWIN FRGA Desi
Edt Project Tools Window Help _ax
H = Q=Y
Desgn & Capture Options
srclsborl.y
Capture Signals
src\sbox2.v Seklaes e n
remove
stc\sbaxdy Qo |AK s
src\shoxdy Sample O © Rising O Falling —
siclsbors.y Capture
src\shoxby Capture Amount: 1024 -
src\sboxT.v GAQ Implementation;  ESRAM -
srcisboxéy [ Enable Capture Data Input Register
stcltop () Capture Initial Data
~ [ Physical Constraints Files
Capture Utilization
srleptéf.cst BSRAM Usage: 0/26 -
~ | GAO Config Files =
stelexptd_Trao,
Design  Process  Hierarchy v Start Page [x] Design Summary. [x] ] top 8 & exptd_lrao ™
& x

Console

WARN  (NL@0@2) : The module
WARN  (NLB0B2) : The module
L (NLBBB2) : The module
(NLOBO2) : The module
(NLOBO2) : The module
WARN  (NL@0O2) : The module
[95%] Generate netlist file
[106%] Generate report file
GowinSynthesis finish

“sbox6” instantiated to "uS” is swept in optimizing(" les\Desktop\exptd_1\src\crp.
“sbox7" instantiated to "u6" is swept in optimizing(" les\Desktop\exptd 1\src\crp.v"
“sbox8" instantiated to "u7" is swept in optimizi _Files\Desktop\expt4_I\src\crp.v"
“key_sel” instantiated to "ul” is swept in optimizing("D:\User_Files\Desktop\exptd_l\src\des.v
“raml” instantiated to "U2" is swept in optimizing("D:\User_Files\Desktop\exptd_1\src\des.v":79)
“divi” instantiated to "Uclk” is swept in optimizing("D:\User_f 5
“D: \User_Files\Desktop\exptd_1\inpl\gusynthesis\exptd_1.vg" completed

“D: \User_Files\Desktop\exptd_1\impl\gusynthesis\exptd 1 syn.rpt.html" completed

iles\Desktop\exptd_1\srcides.v":59)

%

Console  Message
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7. Search for any signal you want to monitor (you must choose at least one). Click OK.

[95%] Generate netlis
[100%] Generate repor:
GowinSynthesis finish

t file
t file

“D:\User_Files\Desl

Dsgn 8 X Capture Options
src\sbox 1w
srctsboxdy Sampl= Clocl N @ s
stcisbody @ =
actebocdy Sample On; @ © Normal O Wildcard O Regular Expression (O Case Sensitive
— [ Advanced Filter
sre\sboxSy Capture
> des/U2/addr{3:0]
src\sboxBv Capture Amour | 5 des/U2/data_in[63:0]
srchsbox 7w GAO Implemen] > des/U2/data_out[63:0]
> des/U2/intemnal_bus[63:0]
stcshoxBy (0 Enable Capt| | > des/U2/ram _regl1023:0]
srcitopar O Capturelni | > des/U2/ronl15:0]
> des/U2/bit[63:0]
v Physical Constraints Files
Capture Utilizat] -
srhexptd_T.cst — s
M GAO Config Files. desrat
sre\exptd_T.rao des/clk in
des/clk
Design  Process  Hierarchy ? Start Pat des/Ulk/clk exptd_rao” a
= des/Ucli/clkout |
Console | des/Ul/decrypt e
RN (NLOOO2) : The module "sbox7" instantiate des/Ul/clk rc\crp.v':
RN (NL0OO2) : The module "sbox8" instantiatd :Eﬁ:;“:;:“’ﬂ’; rc\crp. v
RN (NL@@®2) : The module "key_sel” instantig a:;/uz/:w E:"”’ \src\des
WARN (NL@O®2) : The module “"raml” instantiate sy c\des.v":79)
WARN (NL@0@2) : The module "divi” instantiate

“D:\User_Files\Des|

Concel

- & x

MsB

Ls8

%

Console  Message

8. Save the <project_name>.rao file. If you want to run the GAO tool, run Step 1 of Appendix D. Then, go right into Appendix E afterwards.

MsB

Ls8

Edit Project Tools Window Help
| OpenBcample Project. =Y ELE TP
e [ N CrleN
B S e i’ apture Options
Open.. Cirle0
aws e Capture Signals
doe [k Add Remove
G Sample On: © Rising (O Falling clkin
it
Close "exptd_1.rac’ —
Close All
Capture Amount: 1 -
Close Project
GAO Implementation:  BSRAM -
(e () Enable Cpture Data Input Register
(R Gi0 () Capture Initial Data
Recent Files »
Capture Utlzation
Recent Projects ,
BSRAM Usage: 1/26
Bt
sr\exptd_Ta0
Design  Process  Hierarchy v Start Page [x] Design Summary. [x] ] top 8 & exptd_lrao ™ 2]
Console
WARN (NLO@O2) : The module "sbox7" instantiated to "u6” is swept in optimizing("D:\User_Files\Desktop\exptd_L\src\crp.v":68)
WARN (NL@0@2) : The module "sbox8" instantiated to "u7" is swept in optimizing( les\Desktop\exptd_1\src\crp.v":61)
RN (NLBBO2) : The module “key sel” instantiated to " ng("D: \User_Files\Desktop\exptd 1\src\des.v":124)
RN (NLOPO2) : The module “raml” instantiated to "U2" is s Files\Desktop\exptd_1\src\des.v":79)
WARN  (NL@OO2) : The module "divi® instantiated to “Uclk” is swept in optimizing("D:\User_Files\Desktop\expt_1\src\des.v":59)
[95%] Generate netlist file "D:\User_Files\Desktop\exptd_1\impl\gusynthesis\exptd_1.vg" completed
[100%] Generate report file "D:\User_Files\Desktop\expt4_1\impl\gusynthesis\exptd_1_syn.rpt.html" completed
GowinSynthesis finish
%
Console  Message

14 | EEE 6744 Hands-On Hardware Security

University of Florida



()
2

=
O
<
O
a
L
=
=
o
O]

Running Place/Route tool & Programming the FPGA

1. Goto Process tab on the left sidebar. Right click on Place & Route and click Clean&Rerun All.

Process 8 x

I Design Summary
v [ User Canstraints

Fi

5 Timing Constsints Edtor
@ Synhesize
Syrthess Repart

Hatlist File

« @ Place & Route
Place & Rowt

Fun
Bern

Rerun Al
Clesn&Rerun 21

Powertnsty B So¢ :
Tr——
[ Configuration
T Froces

Comale

Running power analysis......
[169%] Power analysis completed

Generate file
Generate file
Generate file
Generate file
ued Apr 26 16

115 2823

Capture Options

Somple Clock Capture Signals
Code Q1K Add

Sample On: 0 Riing () Falfing devit
des/elkin
Capture

Capture Amount: 1% -
GAQ Implementation:  BSRAM -
) Enable Capture Data Inpust Regester
] Capture Indtial Dets
apture Utilizsticn

SRAM Usage : 1/26

Start Page Design Summary ¥ topv W epuime D

Generate file "D:\User_Files\Desktop\exptd_1\inpl\pnriexptd_1.power.html" completed
User_Files\Desktop\exptd

User_Files\Desktop\exptd_1\inpl\pnriexptd 1.
User_Files\Desktop\exptd_1\inpl\pnriexntd_1.
User_Files\Desktop\exptd_1\iapl\pnriexptd 1.tr.html" completed

1\inpl\pnriexptd_1.pin.htal" completed
ompleted
completed

%

Comole  Message

L8

2. Double click on Program Device on the Process tab. Make sure the Port is set to “Gowin USB Cable(FT2CH)/0/...” If this is not the case,
unplug all USBs and plug in the HaHa FPGA again. Then, click Save on the new window.

v @ Symhesize
Symthesi Report
et Fle

v @ Pace &iRouts
Pisce & Route Report
Timing Analysis Report
Ports & Pins Repart
Powes Anslysis Repart

B8 progeam Devier

Design  Process  Hesnarchy
Comsole

Running power analysis......

[169%] Power analysis completéouput
Generate file "D: i

Generate file
Generate file
Generate file

User_Files\t
8 2803

Comole  Message

15 | EEE 6744 Hands-On Hardware Security

W
3
% & - e -
Process LIE™
I Design Summary
o J— Y T
FloosPlanner Enable S Device Operation 5 File User Code
= Tming ComstrinesEdtor | @ GwiN GWIN-SC SRAM Bragram 0:/User il Desbtop/esptd 1/ Ofs 00000772

e o158 o204 -

Port Gowin USE Cable(rT20-)/0/8 %65/l hd

Py fres 5
Custom LPT Query/Detect Cable
001G o st st (oo, o

Cablafound: Gowin USE Cal
Cable found: Gewin LSE Cablef
Cost 0,18 second(s)

8455/ nall (USB location B465)
848l (USB locatiorsB466)

[

100481

Lse

University of Florida



3. Click on the play button. The bitstream will then be programmed to the FPGA.

[} ;
° & Gowin Programmer Version 19.8.1 - O X
)
O
< & &y S 2 ._\_r\ USE Cable Setting
O Enable Series I’EDe\nca Operation FS File User Code IDC
a 3
L 1@ GWIN GWIN-9C SRAM Program D:/User_Files/Desktop/exptd_1/impl/pnr/an_0.fs Ox0DDD19F3 1100481
=z
O]
= Progress information
Programming...

Cutput & x

Info Cable found: Gowin USE Cable(FT2CH)/1/8463/null (USE location:8465)

Info Cablefound: Gowin USB Cable{FT2CH]/2/8466/null (USB location:G466)

Info Cost 0,72 second(s)

Info Terget Cable: Gowin USE Cable(FT2CH)/1/8485/null@2.5MHz

Info Operation "SRAM Program” is starting on device-1...

|Ready J
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Running the GOWIN Analyzer Oscilloscope tool (Optional

1. Goto Tools > Gowin Analyzer Oscilloscope.

fa File Edi Project Tooks

ow Help.

()
2

=
O
<
O
a
L
=
=
o
O]

o Sanbage ) 5
» ol
e % Gowin Anshyaer Oscillossape
- 1P Core Genesator b Capture Signals
v T user Constraints
Progrmmer Add
FloorPlanner o [ob e
loorPlsnner - Ty e
%, Timing Carst 5% Timing Constraints Editor | Al =) des/ellin

v @ synthesize 2.2 DSim Cloud a

Synthess Ref 58 Optioms punt: 024 S

Matiie File GAQ Implementation: ‘
v @ PucetRoue (0] Ensble Capture Data Inpus Register

Place & Route Report (0] Copture Iniiol Dota

Tiing Analysis Report

Copture Uizstion
Ports & Pins Repor
BSRAM Usage : 1/26
Poer Analysis Reparl 18
B8 Program Device

Deign  Process  Hienarchy ? Start Page Gesign Summary. ] top @  epiine D
Consale ax
Running power analysis......

[18€%] Power analysis completed

Generate file "D:\User_Files\Desktop\exptd_1\inpl\pnriexptd_1.power.html" completed
Generate file "D:\User_Files\Desktop\exptd_1\inpl\pnriexptd_1.pin.html" completed
Generate file "D:\User_Files\Desktop\exptd_1\inpl\pnriexptd_1.rpt.html" completed
Generate file "D:\User_Files\Desktop\exptd_1\ispl\pnriexptd 1.rpt.txt" completed
Generate file "D:\User_Files\Desktop\exptd_1\ispl\pnriexptd 1.tr.html" completed
Wed Apr 26 16:42:08 2823

D

Comole  Message

2. Click on Enable Programmer.

Cable: Gown U8 CatlefTzon) + | (1) (€9

Process | migger

g

— Programmer

v

IE Enatle Programmes
3

Trager

Bamige Doy 0w %

Bii
Design
Comole

Running|
(100%]

Generat
Generat
Generan
Generaty
Generaty
Wed Apr)

Console
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3. Click on the play button.

Fs File

i
— Trigger
Deiigg @ammgor  Delaw o [5
Console
Running
[106%]
Generat
Generat
Generat|
Generat|
Generat
Wied Apr

v @ 5 Enable Series Device Device Version Gperation

1@ Gwin GWN-g c SRAM Program D:/User Files/Desidop/exptd.impl/pnefzo_04s
-~ @

Sutput

Checksum Usel

Ox0BFE

0x0000q

4. Click on the Auto button to start capturing signals.

Gowin Analy:

Operstion

SRAM Program

Fs File

Di/liser_Files/Desktop/exptd_implpni/ao 055

O [ T —
2 @& 1)1
Enatie s Deie | Dedcevaion
'@ awm e c
et Tt Catis G U CatieFT 2000 D/rdlG2, 54z
o Cpsaion AN Frosgan” s startng on e |
1o Stans Code: OXOOUEO
172805201 Cast 3,78 seconc]
L] -
D Baumotgoer Doy ome
or
i
[
Ge
Gel
Gel
Ge
Gel
ey
%
G

Checksum

n7F2e

User Code

BxD000TFZ8
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5. You will now see the captured signals that you set up in the RAO file.

B Gowin Analyzer Oscilloscope
Cable: Gowin USE Cabie(FT2cH) ~ | SHIIESISCR0NS] n @ £
Tripger care 0 windaw O
Autarun Counter: 110
MNarne Value

clk_in 1

()
i

=
(O]
<t
O
a
[T
=
=
o
()
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Programming FPGA without project creation

1. Open GOWIN FPGA Designer. Go to Tools > Programmer. The Programmer window will appear with another window called Cable Setting.

. sanPage [y FEE

Fecent Frojects: e
Schematic Viewss b st
7 ot |
PpufT tas 1P Core Generator

()
2

=
O
<
O
a
L
=
=
o
O]

puf7 est 38 Progammar )
e e e P
ro.test g Cons
+ D Clovd

uf test k
put! A Options. !
exptin_dfa | = g o1

- . 7 I
ses et Frr T G
s _testi2 User Manuals
put est _

foga projectte Manusi for LineBee Manuai for Arora

self_fest fpga_haha3

Sart Page o

2. Make sure the Port is set to “Gowin USB Cable(FT2CH)/0/...” If this is not the case, try unplugging all USB cables and only plugging in the USB
A-to-B cable from the HaHa v3.0 board. Otherwise, press Save.

w

[
Recent Projects:
pufT test ® usB cable ety
Enable Seies Deice Opesstion S File e
7 Sest
Pl 1@  Genen | TG D 15 NOP Byp
o test
puf test
exptio_dfa
ses test
Cave Gonan U6 CatielFT2CH)
ae tust12 Pert Govin S5 Catie FT2CHI 348 il
putsen Frequency P
Custom LT Query Detect Catie
fpga_projectie
e Do HOT shom st e Cancel
sef test fpga hshas — &
oot o x
info i USB CabielFT2CH) VBBl (USE location:5451)
iné Cable(FT2CH) 1/B4E2/null (USE ocation:3422)
ink
1
Ready
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3. Click on the Find Device button (first button below menu bar that has a magnifying glass).

[}
© W N FPGA Designer - [Start Page] - o x
‘5 Q Edit P T ™
(U] ] T = “Fie Edt ol About
< Recent Projects (55| USB Cable seting
O pUf7_test o | Series Device Operation FS File [
o DAUser files\Desktop\pufl testieufl 1 @ ™ General JTAG Device JTAG_NOP Bypass
L PUF7_test
= D\User_Files\Syne\hahav3\puf_test
= rotest
; D:\User_Files\Desktop\ro_test\ro_tes]
(@) Syncihahay3\pu_test
O] expt10_dfa
D\User_Files\Desktophexpt10_dfa\ef
aes_test
D\ser_Files\Desktophaes_testiaes
[_Files\Desktop\aes_test12\ael
puf test
DA\User_Files\Desktop\puf_testipuf {
fpga_projectte
D\User_Files\Documents\fpga_proj
self_test_fpga_haha3 output 8 x
D 1_Files\Desktophself_t Info i Cable found: Gowin USB Cable(FT2CH)/0/8481/null (USB location:2481)
Info  Cable found: Gewin USE Cable(FT2CH)/1/2482/null (USE location:2422)
Info  Cost0.17 second(s)
Ready
5 Start Page (]
 FPGA Designer - [Start Page] = o X
P " 6 - a = _ e x
Recent Projects: Q= ! (59 |; UsB Cable Setting
PUF7_test Enable Series Device Operation FS File [
DAUser files\Desktop\puftestiouf] @ General JTAG Device JTAG_NOP Bypass
pUfT test
D\User_Files\Syncthahav3\puf7_tes
ro_test
D\User_Files\Desktopiro.testiro_tes
puf test 4 Device Chooser
DA\User_Files\Synethahav2\puf test) I Mult-type device found, pease selecton
expt10_dfa
D:\User_Files\Desktophexpt10_dfs\e ELARTE
aes_test GWINR-9C
D\User_Files\Desktophae:
aes test12
D\User_Files\Desktophaes_test12\ae
pUf test
D\User_Files\Desktophpuf_test\puf |
fpga_projecite
DA\User Files\D <\fpga_proj
self_test_fpga_haha3 output @ x
 test fpgall i | CENs
D\User_Files\Desktophself_test fpga]info Cable found: Gowin USB Cabl Loy
Info  Cable found: Gowin USE Cable(FT2CH)/1/8482/null (USE location:2482)
Info Cost 0.17 second(s)
Info Scanning!
Info Brget Cable: Gowin USB Cable(FT2CH)/0/2481/null@2.5MHz
Info 1 devices) found!
Info Cost 057 second(s)
Ready
e Start Page (=}
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5. Double click on Read Device Codes and change the following settings and then Press Save. Then, browse for an FS file using “...” button.

- o
Recent Projects: == (55 | USB Cable Setting
pUFT_test Enable Series Device Operation FS File Bx
DiUser files\Desktopleufl testiont] y @ qwin GWIN-9C Read Device Codes
puf7._test
DAUser_Files\Syne\hahav3\pufT_tes
ro_test
DAUser_Files\Desktopiro_testiro_tes
expt10_dfa Device Operation
u g Phexp
DAUser Files\Desktophexpt Access Mode: Embecided Fiash Mode -
aes_test
Di\User_Files\Desktophaes_test\aes 4 Operation: embFlash Erase, Program, Verify hd
aes testiz Erase and program the embedcied flash and verify Male sure the config frequency must
DAUser_Files\Desktop\aes_test1Z\ae be less than 2sivhe. -
puf_test
DAUser_Files\Desktop\pu._testipu |
fpga_projectte
DAUser_Files\Documents'f jd ————————————————"  ranming Optons
self test fpga_haha3 Output 8 x
File name:

Di\User_Files\Desktophself_test fpgal info Cable found: Gowin USB Cable(

Info Cable found: Gowin USB Cable(| ) User Fiash Initisization

Info Cost 0,17 second(s)

Save Cancel

Info Scanning!

Info Trget Cable: Gowin USB Cable(FT2CH)/0/8481/null@2.5MHz

Info 1 device(s) found!

Info Cost 0,57 second(s)

Ready =
7 Start Page [x]

: - O

Recent Projects: (5 | UsB Cablesetting
PUF7_test Se By
DAUser_Files\Desktop\puf7_testipuf] (. O RRE I [T
pUfT test
D\User_Files\Syncthahav3\puf7_tes
rotest
D\ser_Files\Desktopiro.testiro,_tes Organize ~
puf test Nan Status Date modified
D\User_Files\Synehahav2\puf test
expti0_dfa W sclf test fpga_hahadfs /2872023 2:14 PM FS File
D\User_Files\Desktophexpt10_dfale
aes_test
D:\User_Files\Desktophaes_testiaes_4
aes test12
D\User_Files\Desktophaes_test12\a S
puf test
D\User_Files\Desktophpuf_test\pu |
fpga_projectte
DA\User_Files\Documents\fpga_projd
self_test_fpga_haha3 output 8 x
D\User._Files\Desktopself_test_fpg Cable found:
Info  Cable found:
Info Cost0.17 secd
info Scanning!
Info TBrget Cabler (Tammm=
Info 1 device(s)fo
Info Cost0.57 secd
Ready E

7 Start Page B
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7. Click on Program/Configure (play button).

(]
o o X
‘5 e
(U] B HE A File Edt Teols About
< Recent Projects: as B || U Caleseting
O PUF7_test Enable Series Program,/Configure Operation FS File User Code [i7<c A—
o DAUser Files\Desktop'pufl testipuf| 1 g GWIN GWIN-9C embFlash Erase,ProgramVerify .rse Materials - General/000_HaHa3_OOTE/000_Expts/ | 0<00006962 1100421
(N PUF7_test
= D:\User_Files\Sync\hahav3\puf7._tes
= rotest
; D:\User_Files\Desktophro_test\ro_tes
(@) Syncihahav3\puf test
o expt10_dfa
D\User_Files\Desktopexpt10_dfa\ef
aes_test
Desktop\aes_test\aes |
(_Files\Desktophae
puf test
D:\User._Files\Desktophpuf_t
fpga_projectte
DAUser_Files\Documents\fpga_proj
self test fpga_haha3 output & x
D 1_Files\Desktop! Info Cable found: Gowin USB Cable(FT2CH)/0/8481/null (USB location:2481)
Info Cable found: Gowin USB Cable(FT2CH)/1/8482/null (USE locstion:e422)
Info Cost (.17 second(s)
info Scanning!
Info Target Cable: Gowin USB Cable(FT2CH)/0/8431/null®2.5MHz
Info 1 device(s) found!
Info Cost 057 second(s)
Ready
9 SGrtPage [X]
- o x
= o x - || &) *

Recent Projects: g & ) o caieseng

puf7_test Enable Series Device Operation FSFile User Code b
ser Files\DeskopipufZ testou] | @ | qwin
PUF7._test
DAUser_Files\Synethahav3\puf._test
ra_test
Di\User_Files\Desktopiro_testiro_tes
puf_test
D\User Files\Sync\hahau3\puf_test\
expt10_dfa

GWIN-9C embFlash Erase Program Verify rse Materials - Genera|/000_HaHa3_OCTE/000_Expts/  0:x00006368 1100481

DA\User_Files\Desktophexpt10_dfa\e

aes test

DAUser_Files\Desktophae:
GOWIN Programmer

aes test12

information

D:\User_Files\Deskiop\aes_test12\aef

pUf test
DiAUser_Files\Desktophpuf testypuf
fpga_projectte
DA\User_Files\Documents\fpga_proj
self test_fpga_haha3 Output ax
DAUser Fies\Deskiopse.sest fpga] ™ T TGOS CUWITT U305 aUTEyr T M7 176402 T (U35 T0CauuTiaacy
Info Cost 0.17 second(s)
Info Scanning!
Info TBrget Cable: Gowin USE Cable(FT2CH)/0/8421 /null @2 SMHz
Info 1 device(s) found!
Info Cost 0.57 second(s)
Info Target Cable: Gowin USB Cable(FT2CH)/0/8481/null@2.5MHz
info Operation *embFlash Erase,Program Verify” is starting on device-1...
Ready
9 Start Page. B
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9. The bitstream is then programmed to the embedded Flash.

(]
o Iy - o X
= - o x BB
< Recent Projects =) (55| USB Cable seting
O PUF7_test Enable Series Device Operation FSFile User Code Dt
o DAUser Files\Desktoplpufl testipuf] § gy GWIN GWIN-9C embFlash Erase,ProgramVerify .rse Materials - General/000_HaHa3_OOTE/000_Expts/ 000006962 1100421
L PUf7_test
= D:\User_Files\Sync\hahav3\puf7 _tes
= rotest
; D:\User_Files\Desktophro_testro_tes
(@) hahav3\puf test
o expt10_dfa
D\User_Files\Desktopexpt10_dfa\ed ——
aes_test
\User.Files\Desktophaes test\aes 4
ettt Programming..
puf test
C: |
B i Dopi
fpga_projectte
DA\User_Files\Documents\fpga_proj
self test fpga_haha3 & x
AUser Fle et e
Cost 0,17 second(s)
info Scanning!
Info Terget Cable: Gowin USB Cable(FT2CH)/0/8431/null®2.5MHz
Info 1 device(s) found!
Info Cost 057 second(s)
Info gt Cable: Gowin USB Cable(FT2CH)/0/6481/null@25MHz
Info Operation "embFlash Erase,Program,Verify" is starting on device-1...
Ready
g Start Page [x]

10. After programming, the Programmer will verify the programmed bitstream.

= o x - || &) *
Recent Projects: Q= (59 |; UsB Cable Setting
PUF7_test Enable Series Device Operation FSFile User Cade ocy
DiUser Files\Deskcopipufltestiouf| @ win GWIN-9C embFlash Erase ProgramVeriy .rse Materisls - General/000_HaHe3_OOTB/000_Expts/  0x00006363 1100481
pUfT test
D\User_Files\Syncthahav3\puf7_tes
<\Desktop\ro_testiro ted
pUf_test
DAUser_Files\Syne\hahav3\puf_test|
expt10_dfa
DA\User_Files\Desktophexpt10_dfs\ed ———
aes_test
DA\User_Files Vet
erfying...
aes test12
DAUser_Files\Desktophaes_test12\aef .
pUf_test
D\User_Files\Desktophpuf_test\pu |
fpga_projecite
DA\User_Files\Documents\fpga_proj
self_test_fpga_haha3 output @ x
User P Destomsel test fogal™ SV U110 GO U35 SUIRAT T2 P G0 TUIT (U0 10CAUG1 52
" P9 nfo Cost 0.17 second(s)

Info  Scanning!

Info Brget Cable: Gowin USB Cable(FT2CH)/0/2481/null@2.5MHz

Info 1 device(s) found!

Info Cost 057 second(s)

Info  Terget Cable: Gowin USB Cable(FT2CH)/0/B431/null@2.5MHz

Info Operation *embFlash Erase, Program Verify' is starting on device-1...

Ready
9 Start Page a8
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11. If the programming is successful, you should see the message in the bottom of the Programmer window.

$ cow

o X

B o % File Edt Teols About

Recent Projects: [ (55| UsB Cable Setting

PUF7_test Enable Series Device Operation FSFile User Code e —
DAUser Files\Desktop'pufl testipuf| 1 g GWIN GWIN-9C embFlash Erase,ProgramVerify .rse Materials - General/000_HaHa3_OOTE/000_Expts/ 000006962 1100421
PUf7_test =
D:\User_Files\Sync\hahav3\puf7._tes
rotest

D:\User_Files\Desktop\ro_test\ro_tes}
puf test

DA\User_Files\Syncthahav3\puf_test)
expt10_dfa

()
2

=
O
<
O
a
L
=
=
o
O]

DAUser_Files\Desktophexpt10_dfa\ef

aes test
" Files\Desktop! aes test\aes ¢
aes testiz

DAAUser_Files\Desktophaes_test12\ae =

puf test
DA\User_Files\Desktophpu test\puf |
fpga_projectte

DAUser_Files\Documents\fpga_proj

self test fpga_haha3 output 8 x
DA\User Files\Desktophself_test foga] t e

Info Target Cable: Gowin USB Cable(FT2CH)/0/8481/null@2.5MHz.

Info Operation *embFlash Erase, ProgramVerify" is starting on device-T..

Info Verify success!

Info Status Code: 0x0001F020

Info User Code: 0x00006966

Info Program Finished!

Info Cost 3332 second(s)

Ready =
4 ‘Start Page [x]
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